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ABSTRACT
[bookmark: YearConference]This document provides instructions for producing a proceedings paper for the 2026 Winter Simulation Conference (WSC) with Microsoft Word. It also serves as a sample file that you can edit to prepare your submission, and a checklist to ensure that your submission meets the WSC 2026 requirements. Please follow the guidelines provided in this document when preparing your paper. Failure to do so may lead to your paper being rejected, returned for appropriate revision, or edited without your prior knowledge.
INTRODUCTION
[bookmark: TemplateFile]This paper provides instructions for preparing papers for the 2026 Winter Simulation Conference (WSC) with Microsoft Word. There is a companion paper that provides instructions for the preparation of papers using LaTeX. The easiest way to write a paper using Microsoft Word that complies with the requirements is to use the WSC26_InstructionsForAuthors_PapersUsingWord.docx template file. Do not use an older version, as some specifications have changed. 
An author kit is available via the conference website. The author kit includes this Microsoft Word document and its LaTeX companion. It also includes guidelines that you may find helpful for writing a conference paper and for giving a presentation. 
When preparing your paper in Word, you are required to use the Word template. The easiest way to use this template is to copy the template to your working directory and double-click the template from your operating system. This will launch Word and will create a new document based on the template. 
A set of styles are defined in the template so that authors can easily achieve the required format. You should look carefully at how the styles are applied in this document. One simple way to get started with styles is to start with the sample paper and replace the existing text. Do not try to make “manual” formatting changes to the text – let styles do the work. For example, instead of manually indenting paragraphs to conform to the WSC 2026 specifications, simply apply the corresponding predefined style from Table 1; the paper will then meet indenting requirements. To view the styles defined in the template, open the Styles Panel by clicking the bottom right corner arrow button in the “Styles” group on the “Home” ribbon in MS Word 2010 (please use MS Word help to identify corresponding capabilities in other versions). The Styles panel also shows the style currently applied to the text at the current cursor position as the boxed style in the list. To apply different formatting, choose the appropriate style from the list. The specific formatting instructions for a style may be viewed by placing the cursor over the style of interest. For additional help with styles, review the Word Help topic “Style basics in Word.” Avoid updating the styles that are provided; the proceedings editors have checked that the formatting provided by the styles is that needed for the WSC. 
Note that some styles appearing in this paper’s styles set are not found in earlier WSC templates nor in Table 1 because formatting that is added during the normal editing process will appear in the Style Area Panel. The safest way to ensure conformance to formatting requirements is to apply only styles that are listed in Table 1. The template file will not permanently change the setting of your Microsoft Word. Hence, the next time you run Microsoft Word and create a new document from its menu, the “Styles” group will revert back to your original setting.
GENERAL GUIDELINES
Language
The paper must be prepared using U.S. English to ensure consistency across the proceedings. The language can be set in MS Word 2010 via File > Options > Language settings, and selecting “English (United States)” from the drop-down menu.
Paper Submission
You will need to electronically submit the paper in Portable Document Format (.pdf) through the conference website. The .pdf file format allows for automatic page counting and ensures that the page limit has been followed. If the paper is accepted, you will also need to electronically submit the word-processor source file (.docx) for the final version of your paper. The editors may return the file to you with the request to make changes to conform to conference guidelines. For minor changes, the editors may make the changes themselves. The final .pdf files are generated by the conference proceedings editors.
You will also need to transfer the copyright of your article to the WSC using the copyright transfer form that will be available via the conference website at the appropriate time. For your paper to be published by the WSC, you must complete the transfer of copyright. When you have successfully transferred the copyright, you will receive a .pdf receipt. 
If you are unable to satisfy these requirements, you should contact the proceedings editors.
Objectivity
The content of the paper should be objective and without any appearance of commercialism. In general, comparisons of commercial software should be avoided unless they are central to the topic. If a comparison of commercial software is included, it should be based on objective analysis that includes criteria, a description of ranking methodology on each criterion, and the rankings themselves to arrive at a conclusion. If an approach other than a detailed objective analysis is used to select the simulation software used for the study being reported, such as the availability of the software, or the familiarity of the analyst with the software, it should be clearly identified.
Length Constraints
Length of the Abstract
The abstract must not exceed 150 words. Since abstracts of all papers accepted for publication in the proceedings will also appear in the final program, the length limit of 150 words will be strictly enforced for each abstract. The abstract should consist of a single paragraph, and it should not contain references or mathematical symbols. Do not include a list of keywords as they are not used in WSC proceedings.
Length of the Paper
The page size in the proceedings must be 8.5 inches by 11 inches (21.6 cm by 27.9 cm). The overall length of the paper should be at least five proceedings pages. Papers including bibliography and author biography should be at most twelve (12) pages, except for introductory tutorials, advanced tutorials, and panel sessions, for which the limit is 15 pages. Exceeding the page limit will result in rejection for the proceedings.

Table 1: Defined Word styles.
	Style Name
	Description

	Abstract Heading
	Heading style for abstract

	Appendices
	Appendix heading

	AuthorAddress
	(only for author address block)

	AuthorBio
	Author biographies

	Definition
	Definitions, Theorems, and Corollaries

	Equation
	Equations (without numbers)

	EquationNumbered
	Equations (with numbers)

	Figure Content
	Figures

	Figure Label
	Single-line figure caption

	Figure Label Multiline
	Multiline figure caption

	Heading unnumbered
	Unnumbered headings – e.g. References, Acknowledgments, Author Biographies, etc.

	Heading i
	Numbered headings for level i headings

	Hyperlink
	Hyperlinks (character format, mark only the characters to form the hyperlink)

	List Bulleted
	Bulleted lists

	List enum
	Numbered lists

	Normal
	Normal text – no indent – used for first paragraphs after headings

	Normal Indent
	Normal text – indented – used for all paragraphs following the first for a section.

	Program body
	“in-between” lines in a program listing

	Program one line
	Single-line program statements

	ProgramEnd
	Last line in a program listing

	ProgramStart
	First line in a program listing

	Reference
	References

	Table Label
	Single-line table caption

	Table Label Multiline
	Multiline table captions

	Title
	Paper title


Font Specification and Spacing
The paper should be set in the Times New Roman font using an 11-point font size. The paper should have a 12.5pt line spacing. Do not use other fonts; use of other fonts means the proceedings editors will need to send the paper back to you to change the font.
[bookmark: _Margins]Margins
All margins are correctly defined in the provided template. Therefore, you should not need to care about margins at all, and you may skip this section. Should you have, by accident, destroyed the styles used there, please restore the following styles: In the header of the first page, use the styles “HeadEditor1” and “HeadEditor2” for the first and second line, respectively, and on the other pages, use the style “HeadAuthor” (never more than one line here). 
Just for experts wishing to know the exact configuration, the width of the text area is 6.5 inches (16.5 cm). All four margins are 1 inch (2.54 cm) on each page. In this MS Word template, the header and footer are set to, respectively, 0.69 inches (1.75 cm) and 0.75 inches (1.90 cm). The heading on the first page has no additional margin (effective heading 0.69 inches), while the running head with the authors’ names has an additional margin of 0.2 inches (0.51 cm), leading to an effective header position of 0.89 inches (2.26 cm) for all pages except the first one. The heading on the first page provides an additional margin of 0.5 inches (1.27 cm), leading to an effective title position of 1.5 inches (3.81 cm). Authors should neither change these header and footer settings nor the corresponding MS word styles when preparing a manuscript. 
Justification
Headings of sections, subsections, and subsubsections should be left-justified. One-line captions for figures or tables should be centered. A multiline caption for a figure or table should be fully justified. All other text should be fully justified across the page (that is, the text should line up on the right-hand and left-hand sides of the page).
Headings of Sections, Subsections, and Subsubsections
Section, subsection, and subsubsection headings should appear flush left, set in the bold font style, and numbered as shown in this document. The headings for the Abstract, Acknowledgments, References and Author Biographies sections are not numbered. Section headings should be set in FULL CAPITALS LIKE THIS PHRASE, while subsection and subsubsection headings should be Capitalized in Headline Style like This Phrase. Lengthy headings should be broken across two or more lines. Again, these formats should be accomplished using the styles Heading 1, Heading 2, Heading 3, etc.
Paragraphs
The first paragraph after a heading should not be indented; all other paragraphs should be indented by 0.25 inches (0.63 cm). Do not insert additional space between paragraphs.
Programming code should use “Program Start,” “Program body,” and “Program End” Styles with the following guidelines.

class Exponential{
…// Properties of the Exponential
};

One-line programs should use the “Program one line” style.

Exponential interArrival;
Footnotes
Do not use footnotes; instead, incorporate such material into the text directly or parenthetically.
Page Numbers
Do not include page numbers. Page numbers are generated by the proceedings editors once all accepted papers are ordered for the final proceedings.
FORMATTING THE FIRST PAGE
Running Heads
The running head (provided in the template) in the upper left-hand corner of the first page (which should read Proceedings of the 2026 Winter Simulation Conference …) is left-justified and set in the 11-point italic font style. You do not have to change the content of the first-page header; the first-page header was set by the proceedings editors in the preparation of this document.
Running heads on the second and subsequent pages should contain the last names of the authors, centered and set in the 11-point italic font style. For example, running heads for papers would appear like Justme for papers with one author, or Justme and Him for papers with two authors, or Justme, Him, and Youtoo for papers with three authors, etc. Separate the last names of the authors with a comma, except for the last author use “, and”. List all authors; do not use et al. except if they don’t fit on one line. In the latter case, only the first author is given followed by “et al.”. The author names are listed in the same order as they appear on the title page. This will be the same order when providing the author biographies at the end of the paper. Once on the second page of your document, view the header and make the appropriate changes.
Title and Authors
Center the title of the paper on the page and set it in bold FULL CAPITALS. Multiline titles should have about the same amount of text on each line. There should be two blank lines between the title and the authors’ names. 
All authors’ names should have initial letters capitalized and be listed on a line in a centered fashion, with the author’s first name first and no job title or honorific. In the case of many authors, multiple centered lines might be used to list all authors. Behind each author’s name is superscript 1, 2,  3, etc., denoting the author’s affiliation. If an author has multiple affiliations, then only the main affiliation should be listed unless it is strictly necessary to use multiple affiliations, in which case the superscript could consist of multiple indices, e.g., 1,2. On the other hand, each affiliation could apply to multiple co-authors. These affiliations are detailed under the authors’ names, with one blank line between authors’ names and the affiliation details. Each affiliation starts with the superscript index, then the department, institution, city, standard two-letter state or province abbreviation, and country. The state abbreviation and country name should be in FULL CAPITALS. Each affiliation should be detailed in a single centered line to the extent possible, by using common abbreviations, e.g., “Dept.” for “Department”, “Eng.” for “Engineering”, and other common-sense abbreviations if needed. However, using multiple lines is acceptable if a single line is not sufficient to detail the affiliation even after a reasonable effort to abbreviate. For papers with multiple authors, the authors should be listed in order of decreasing contribution. Some examples of title page headings and common-sense abbreviations are shown in Figures 3-7 and Table 4, respectively, at the end of this document. There should be two blank lines between the author fields and the text of the paper. Do not include email addresses on the first page; emails for authors are provided in the author biographies. 
FORMATTING SUBSEQUENT PAGES
Please refer to Section 2.6 for the correct margins.
Mathematical Expressions in Text and in Displays
Display only the most important equations, and number only the displayed equations that are explicitly referenced in the text. Assign the style "Equation" and add one empty line above and below the equations. If two equations are printed in direct sequence, do not add a blank line between them. 

To conserve space, simple mathematical expressions such as  may be incorporated into the text. Mathematical expressions that are more complicated or that must be referenced later should be displayed, as in 

.
If an equation is referenced in the text, then enclose the equation number in parentheses and place it flush with the right-hand margin of the column. Add a tabulator before and after the equation and use the style "EquationNumbered" to get this effect. For example, the quadratic equation has the general form

	,  where  	(1)

In the text, each reference to an equation number should also be enclosed in parentheses. For example, the solution to (1) is given in (3) in Appendix A. Note that equation numbers are not automatically generated or referenced.
If the equation is at the end of a sentence, then you should end the equation with a period. If the sentence in question continues beyond the equation, then you should end the equation with the appropriate punctuation – that is, a comma, semicolon, or no punctuation mark. If the equation is not included within any sentence, but just given between two paragraphs, no punctuation is used as in equation (2). 

		(2)

If you are using Microsoft Equation Editor 3.0, select the “EquationNumbered” style on the line where the equation will appear. Then, press the TAB key to move the cursor to the center of the column. From Word’s Insert ribbon, select Object in the Text group. In the pull-down menu that appears, select Object, and in the Object panel, select type Microsoft Equation 3.0, and type the equation. While in the Equation Editor, you should verify that the font size is at most 11 points. On the Equation Editor’s menu bar, select Size > Define, and set the “Full” font size to 11. Close the Equation Editor. To include the equation number, press the TAB key. This will move the cursor to the right-hand margin; then type the equation number enclosed in parentheses. If you don’t need to number the equation, use the “Equation” style and leave out the tabs. 
If you are using MathType, click the “Insert Display Equation” button on MathType’s Equation Editor menu bar. Before you type the equation, verify that the font size is at most 11 points by choosing Size > Define. After typing the equation, close the MathType Equation Editor, press the TAB key to move the cursor to the right margin, and type the equation number, if any, enclosed in parentheses. For unnumbered equations, MathType users should click the “Insert Display Equation” button.
Entering equations using the Equation option available in the Symbols group on the Insert tab in Microsoft Word 2007 or 2010 is not recommended. For Microsoft Word 2007 or 2010, the equation capability makes entering equations quite convenient but numbering them requires using tables. Instructions for inserting equation numbers for Microsoft Word 2007 and 2010 are available online at WordTips (Sharon Parq Associates 2018). 
Displayed Lists
A displayed list is a list that is set off from the text, as opposed to a run-in list that is incorporated into the text. The bulleted list given below provides more information about the format of a displayed list. 

Use the “Lists Bulleted” style that leads to standard bullets instead of checks, arrows, etc.,
For numbered lists, use the “List Enum” style with Arabic numbers,
You may need to restart the numbering on numbered lists. To do so, right click on the first entry in the list.

Indent the paragraph after the list. Include an empty line before and after the list.
Figures and Tables
Figures and tables should be centered within the text and should not extend beyond the right and left margins of the paper. Figures and tables can make use of color since the WSC produces electronic proceedings. However, try to select colors that can be differentiated when printing in black and white in consideration of people using such printers. Figures and tables are numbered sequentially, but separately, using Arabic numerals. All tables and figures should be explicitly referenced in the text and they should not be placed before they are referenced. The reference is always written in full (Figure 1), and never abbreviated as in “(Fig. 1)”. For figures which can fit next to each other, the author can choose to align them next to each other with the figure text centered below each figure and on the same line for both figures. For tables which can fit next to each other, the author can next to also choose to align them each other with the table text centered above each table and on the same line for both tables.
To insert a table, use the usual Table option on the Insert ribbon. To center the table, first select the table, then right-click and select Table Properties, followed by the Table tab and click the Center button for Alignment and the None button for Text wrapping. Each table should appear in the document after the paragraph in which the table is first referenced. However, if the table is getting split across pages, it is okay to include it after a few paragraphs from its first reference. The table’s single-line captions are centered, while multiline captions are fully justified. This template does not use the Word capabilities to insert table captions and, thus, does not use the automatic referencing capabilities of Word. Instead, add the appropriate caption above the table and use the “Table Label” style for tables with a single-line caption. Use the “Table Label Multiline” style for multiline table captions. The styles include inserting a 12 pt. space above and a 6 pt. space after the caption. The caption should begin with the word Table, followed by the table number and a colon. Captions can be written using normal sentences with full punctuation. All captions should end with a period. It is fine to have multiple-sentence captions that help to explain the table. Include one line space below the table. See Tables 2 and 3 for examples.
Table 2: Table captions appear above the table, and if they are longer than one line they are fully justified. Captions are written using normal sentences with full punctuation. It is fine to have multiple-sentence captions that help to explain the table.
	Creature
	IQ
	Diet

	dog
	70
	Anything

	human
	60
	ice cream

	dolphin
	120
	fish fillet



Table 3: Comparison between samples.
	Sample
	Height (cm)

	Plant one
	50

	Plant two
	58



Each figure should appear in the document after the paragraph in which the figure is first referenced. However, if the figure is getting split across pages or is leading to an empty space at the bottom of the page, it is okay to include it after a few paragraphs from its first reference. Figure captions appear below the figure. Single-line captions are centered, while multiline captions are fully justified. This template does not use the Word capabilities to insert figure captions and, thus, does not use the automatic referencing capabilities of Word. Instead, add the appropriate caption below the figure and use the “Figure Label” style to label the figure for a single-line caption. Use the “Figure Label Multiline” style for multiline captions. The styles include inserting a 6 pt. space above and a 12 pt. space after the caption. Include one line space above the figure. The caption should begin with the word Figure, followed by the figure number and a colon. Captions end with a period. See Figures 1 and 2 for examples.
Paste complete figures as pictures into the document (avoid drawing the picture within Word directly). To format the picture, select it and then use the “Figure Content” style. The picture will be formatted centered and have one line space above the figure. 

[image: MathExpandExpression]
[bookmark: fig_unusual_answer]Figure 1: An unusual answer to a question.

[image: ]
[bookmark: fig_squares]Figure 2: The area of the square is 64 squares, while that of the rectangle is 65 squares, yet they are made of the same pieces! How is this possible?
References to tables and figures identified by number are capitalized. Avoid using “in the previous table” or “in the figure below”, as positions might change in the final formatting.
Please ensure that the text within figures uses standard fonts and is readable: Arial (recommended), Symbol, etc. The minimum font size should be around 9pt (Arial). Remember that you might need larger fonts in your original figure if you reduce the size of the figure in your WSC paper to less than 100% (e.g., when you insert your figure with 50% of its original size, your original fonts have to be >=18pt.). This applies to all text elements in the figure, including captions of axes, etc. 
Definitions and Theorems
Definitions, theorems, propositions, etc. should be formatted like a normal paragraph with boldface heading as shown in the examples below. Number these items separately and sequentially. You may choose to separate theorems, propositions, corollaries, etc., as opposed to the example below, where corollaries and theorems are numbered together. Use the “definition” style, also for theorems and corollaries. Do not use a period after the definition, theorem, corollary or proposition number, but do end the sentence with a period.
Definition 1 In colloquial New Zealand English, the term dopey mongrel is used to refer to someone who has exhibited less than stellar intelligence.
Theorem 1 If a proceedings editor from New Zealand accidentally deletes his draft of the author kit shortly after completing it, he would be considered to be a dopey mongrel.
Corollary 2 One of the proceedings editors is a dopey mongrel.
Indent the paragraph after the definition or theorem.
Hyperlinks
A hyperlink specifies a web address (URL) or an e-mail address. The use of hyperlinks allows authors for providing readers access to external electronic information, such as a dynamic simulation or animation. While the use of hyperlinked text is encouraged in the main body of the paper, it is recommended that corresponding web addresses and other identifying information should be provided in the list of references. For example, instead of spelling out the web address of the conference website, one would refer to the conference website and the corresponding entry in the reference section will spell out the associated web address and other relevant information such as author(s) and/or organization that published the content. This would allow readers to search for the content using the author(s), organization, etc. if the actual web address is changed. This also allows for a cleaner appearance of the main body of the paper.
If the author(s) feel that sufficient information is provided in the main body of the paper to locate the content even if the web address is changed, the address can be included in the main body of the paper itself.
Each hyperlink should be set in the same font as the text. Hyperlinks are not underlined. A live hyperlink (or hot link) – that is, a hyperlink that will activate your web browser and take it to an external website or that will activate your e-mail software for sending a message to a specific e-mail address – should be colored blue. You can see examples of such hyperlinks in this paper. The use of live hyperlinks is at the discretion of the author(s), except in the author biographies.
Using live hyperlinks requires the format defined in the “Hyperlink” style. To insert a live hyperlink into a WSC paper, please follow the following steps:

1. In the current paragraph style, enter the text where the live hyperlink is to appear.
1. With the displayed text selected, choose Insert > Hyperlink from the ribbon or right-click and select “Hyperlink.”
1. In the dialog box that appears, select the button labeled “Existing File or Web Page” or “E-mail address.” 
1. In the second box labeled “Address” type only the correct e-mail or web address, with the prefix http:// or https:// for a web address.
1. If not done automatically, select the displayed text of the live hyperlink and apply the “Hyperlink” style.
1. For hyperlinks with web addresses, enter an appropriate citation following the text and provide the web address and other relevant information in the corresponding entry in the list of references.

If any editing is made to the displayed text of a live hyperlink, then the “Address” box referred to above should be rechecked to ensure no extraneous characters have been introduced into that box. To check the “Address” box for accuracy, place the cursor anywhere in the displayed text of the hyperlink and right-click. Select “Edit Hyperlink.” If extraneous characters have been introduced, delete them from the “Address” box.
If it is necessary to break the displayed text of the e-mail or web address across two or more lines, then you can “edit the hyperlink” in MS Word. There are two fields, one for the original hyperlink and the other one for the display, where you can add spaces or soft breaks without influencing the actual link. 
Non-live hyperlinks – that is, the hyperlinks that are included for the reader’s information but do not actually invoke the reader’s web browser or e-mail software – should be colored black. 
Citing a Reference
To cite a reference in the text, use the author-date method. Thus, Chien (1989) could also be cited parenthetically (Chien 1989). Do not use a comma within this parenthesis. For a work by three or more authors, use an abbreviated form. For example, a work by Banks, Carson, and Nelson would be cited in one of the following ways: Banks et al. (2000) or (Banks et al. 2000). 
Parenthetical citations are enclosed in parentheses ( ), not square brackets [ ]. Semicolons separate the items in a series of such citations. 
The following is a list of correct forms of citations:
[bookmark: _Hlk63846532]
Brown and Edwards (1993)
(Brown and Edwards 1993)
(Smith 1987; Brown and Edwards 1992; Brown et al. 1995)

The following is a list of incorrect forms of citations:

Brown and Edwards [1993]
(Brown and Edwards, 1993)
(Smith, 1987; Brown and Edwards, 1993)
(Smith 1987, Arnold, Brown and Edwards 1992, Brown et al. 1995)

General Style and Sequence of References
Place the list of references after the appendices. The section heading is REFERENCES, and is not numbered (use style “heading”). List all references that are cited in the text, but only those. The only exceptions are papers in the “tutorial” tracks: Here it is permitted to have an additional section heading ADDITIONAL READING after references, followed by further literature that is recommended for continued studies but not directly used within the text of the paper. 
Use hanging indentation to distinguish individual entries (use the style “Reference”). Do not insert additional space between references. References have a reduced font of 9 pt and a line spacing of 10.5 pt. Do not number the references and arrange them in the following order:

By the last name of the first author
For papers with the same first author, arrange first all papers by this author only, then all papers by this author and one co-author, and finally all papers with this author and two or more co- authors
Within this sorting sequence, arrange papers by year 

To identify multiple references by the same authors and year, append a lower-case letter to the year of publication, for example, 1984a and 1984b. The same applies to references that have more than two authors and the same first author and year. 
Give complete references without abbreviations. List all authors except when there are more than six authors, in which case the first six author names are shown followed by “et al.”. 
The following sections specify the requested content for several types of references. Examples can be found in the references and additional reading sections, which include:

A technical report (Chien 1989)
A proceedings article with book publication (Cheng 1994)
A conference contribution without book publication (Rabe et al. 2017)
A journal article with two authors (Powell and Mustafee 2017)
A journal article with more than two authors (Gupta et al. 1973)
A book by two (2) authors (Hammersley and Handscomb 1964)
A chapter in a book (Schruben 1979)
An unpublished thesis or dissertation (Steiger 1999)
A book with no identified authors (The University of Chicago Press 2010)
A document available on the Web (WSC 2026)
Formatting References According to Their Type of Publication
Journal Articles
The bibliographic style for a journal article is: <Surname of first author>, <Author’s initial(s)>, <Initials and surnames of other authors>. <year>. <Capitalized article title in quotes>. <Journal Name in Headline Italics> <Volume number>(issue number):<page numbers>.

Gupta, S. S., K. Nagel, and S. Panchapakesan. 1973. “On the Order Statistics from Equally Correlated Normal Random Variables”. Biometrika 60(2):403–413.
Powell, J. H. and N. Mustafee. 2017. “Widening Requirements Capture with Soft Methods: An Investigation of Hybrid M&S Studies in Healthcare”. Journal of the Operational Research Society 68(10):1211-1222.
Books
The bibliographic style for books is: <Surname of first author>, <Author’s initial(s)>, <Initials and surnames of other authors>. <year>. <Book Name in Headline Italics>. [<edition> ed. ]<city of publication>: <publisher>. 

Banks, J., J. S. Carson, B. L. Nelson, and D. M. Nicol. 2000. Discrete-Event System Simulation. 3rd ed. Upper Saddle River, New Jersey: Prentice-Hall, Inc.
Hammersley, J. M. and D. C. Handscomb. 1964. Monte Carlo Methods. London: Methuen.
Law, A. M. and W. D. Kelton. 2000. Simulation Modeling & Analysis. 3rd ed. New York: McGraw-Hill, Inc.
Book Contributions
The bibliographic style for book contributions is: <Surname of first author>, <Author’s initial(s)>, <Initials and surnames of other authors>. <year>. <Capitalized article title in quotes>. In <Book Name in Headline Italics>, edited by <Initials and surnames of editors>, <page numbers>. <city of publication>: <publisher>. Publishers are not abbreviated (e.g., “ASIM”) but written in full (e.g., “Arbeitsgemeinschaft Simulation”).
 
Schruben, L. W. 1979. “Designing Correlation Induction Strategies for Simulation Experiments”. In Current Issues in Computer Simulation, edited by N. R. Adam and A. Dogramaci, 235–256. New York: Academic Press.
Conferences (except Winter Simulation Conferences)
For conferences that have been published as an (electronic) book publication (with editors, publisher, ISBN), use the same style as for book contributions (take care to specify the city of publication, not the conference location). 
For conferences that have not been published as a book, the bibliographical style is: <Surname of first author>, <Author’s initial(s)>, <Initials and surnames of other authors>. <year>. <Capitalized article title in quotes>. <Conference Name in Headline Italics>, <full date(s) of conference>, <location of conference>, <page numbers if available>.

Rabe, M., F. Dross, and A. Wuttke. 2017. “Combining a Discrete-event Simulation Model of a Logistics Network with Deep Reinforcement Learning”. In Proceedings of the MIC and MAEB 2017 Conferences, July 4th-7th, Barcelona, Spain, 765-774. 
Papers from Winter Simulation Conferences
For WSC papers, use the bibliographic style: <Surname of first author>, <Author’s initial(s)>, <Initials and surnames of other authors>. <year>. <Capitalized article title in quotes>. In <Year in Italics> Winter Simulation Conference (WSC), <page numbers> <hyperlinked doi site>. The information provided above follows the bibtex code exported directly from the IEEE website for a considered paper. This reference format specific for WSC papers is designed to reduce the workload of authors (otherwise, WSC papers would be counted as book contributions which, as described previously, would require listing editor names and also full publisher names and city of publication, i.e., Institute of Electrical and Electronics Engineers, Inc. in Piscataway, New Jersey). 
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Figure 4: Example title page heading with one of the authors having multiple affiliations. Note that listing multiple affiliations for an author is used only if it is strictly needed, otherwise only the main affiliation should be listed. 


First Name Last Name 11, and First Name Last Name 21

1Department 1, Institution 1, City 1, STATE 1, COUNTRY 1

Figure 5: Example title page heading with both authors having the same affiliation.


First Name Last Name 11,2, First Name Last Name 21, and First Name Last Name 33

1Department 1, Institution 1, City 1, STATE 1, COUNTRY 1
2Department 2, Institution 2, City 2, STATE 2, COUNTRY 2
3Department 3, Institution 3, City 3, STATE 3, COUNTRY 3

Figure 6: Example title page heading with one of the authors having multiple affiliations, one of which is identical to that of another author.


First Name Last Name 11, First Name Last Name 21, First Name Last Name 32
First Name Last Name 43, and First Name Last Name 54

1Department 1, Institution 1, City 1, STATE 1, COUNTRY 1
2Department 2, Institution 2, City 2, STATE 2, COUNTRY 2
3Department 3, Institution 3, City 3, STATE 3, COUNTRY 3
4Department 4, Institution 4, City 4, STATE 4, COUNTRY 4

Figure 7: Example title page heading that requires two lines to list all author names. Note that when multiple lines are needed to list all author names like here, the length of each line should be made roughly equal.

	


eXAMPLES OF ABBREVIATIONS FOR AFFILIATIONS (TITLE PAGE)
Table 4: Examples of common abbreviations used in affiliations in the title page heading. These examples are not exhaustive nor definitive, and the authors can use any common-sense abbreviations if needed to streamline their affiliations (with the goal of keeping an affiliation within one single line).
	Full Phrase
	Abbreviation

	Department
	Dept.

	Engineering
	Eng.

	Management
	Mgmt.

	Operations Research
	Op. Res. or OR
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